
Chapter 9

Editing Dimensions

After completing this chapter, you will be able to:
• Edit dimensions.
• Stretch, extend, and trim dimensions.
• Use the DIMEDIT and DIMTEDIT command options to edit dimensions.
• Update dimensions using the DIM command, update DIMSTYLE, and apply commands.
• Use the PROPERTIES command to edit dimensions.
• Dimension in model space and paper space.

Learning Objectives
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Figure 9-1  Original location of lines and
dimensions

Figure 9-2  New location of lines and dimensions

Example 1 Mechanical

EDITING DIMENSIONS USING EDITING TOOLS
For editing dimensions, AutoCAD LT has provided some special editing commands that work
with dimensions. These editing commands can be used to define a new dimension text, return
to the home text, create oblique dimensions, and rotate and update the dimension text. You can
also use the TRIM, STRETCH, and EXTEND commands to edit the dimensions. In case the
dimension assigned to the object is a true associative dimension, it will be automatically updated
if the object is modified. However, if the dimension is not true associative dimension, you will
have to include the dimension along with the object in the edit selection set. The properties of
the dimensioned objects can also be changed using the PROPERTIES Palette or the Dimension
Style Manager.

Editing Dimensions by Stretching
You can edit a dimension by stretching it. However, to stretch a dimension, appropriate definition
points must be included in the selection crossing or window. As the middle point of the dimension
text is a definition point for all types of dimensions, you can easily stretch and move the dimension
text to any location you want. When you stretch the dimension text, the gap in the dimension
line gets filled automatically. When editing, the definition points of the dimension being edited
must be included in the selection crossing box. The dimension is automatically calculated when
you stretch the dimension.

Note
The dimension type remains the same after stretching. For example, the vertical dimension maintains
itself as a vertical dimension and measures only the vertical distance even after the line it
dimensions is modified and converted into an inclined line. The following example illustrates the
stretching of object lines and dimensions.

In this example, you will stretch the objects and dimensions shown in Figure 9-1 to a new
location using grips. The new location of the lines and dimension is at a distance of 0.5 in the
positive Y axis direction. See Figure 9-2.
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1. Choose the Stretch button from the Modify toolbar. The prompt sequence is as follows:

Select objects to stretch by crossing-window or crossing-polygon
Select objects: Specify opposite corner: Define a crossing window using the first and second
corner as shown in Figure 9-1.
Select objects: �
Specify base point or [displacement]<Displacement>: Select original vertex using the osnaps
as the base point.
Specify second point of displacement or <use first point as displacement>: @0.5<90

2. The selected entities will be stretched to the new location. The dimension that was initially
1.75 will become 2.25 and the dimension that was initially 2.30 will become 2.70, see
Figure 9-2. Press ESC to remove the grip points from the objects.

The two dimensions in Figure 9-3(a) are too close. Fix the drawing by stretching the dimension
as shown in Figure 9-3(b).

1. Stretch the outer dimension to the right so that there is some distance between the two
dimensions.

2. Stretch the dimension text of the outer dimension so that the dimension text is staggered
(lower than the first dimension).

Editing Dimensions by Trimming and Extending
Trimming and extending operations can be carried out with all types of linear dimensions
(horizontal, vertical, aligned, rotated) and the ordinate dimension. Even if the dimensions are
true associative, you can trim and extend them. AutoCAD LT trims or extends a linear dimension
between the extension line definition points and the object used as a boundary or trimming

Figure 9-3  Drawing for Exercise 1, stretching dimensions

Exercise 1 General
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Figure 9-6  Drawing for Exercise 2

Exercise 2 Mechanical

edge. To extend or trim an ordinate dimension, AutoCAD LT moves the feature location (location
of the dimensioned coordinate) to the boundary edge. To retain the original ordinate value, the
boundary edge to which the feature location point is moved should be orthogonal to the measured
ordinate. In both cases, the imaginary line drawn between the two extension line definition
points is trimmed or extended by AutoCAD LT, and the dimension is adjusted automatically.
Figures 9-4 and 9-5 show the dimensions edited by trimming and extending.

Use the Edgemode > Extend option of the TRIM command to trim the dimension in
Figure 9-6(a) so that it looks like Figure 9-6(b).

1. Make the drawing and dimension it as shown in Figure 9-6(a). Assume the dimensions
where necessary.

2. Trim the dimensions by setting the Edgemode option of the TRIM command to Extend.

Figure 9-4  Dimensions edited by extending Figure 9-5  Edgemode extended trimming
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Flipping Dimension Arrow
From this release of AutoCAD LT, you can flip the arrowheads individually. To flip the arrow,
select the dimension. Place the cursor on the grip corresponding to the arrowhead you want to
flip. When the color of the grip turns green, invoke the shortcut menu by right clicking and
choose the Flip Arrow option from the shortcut menu.

MODIFYING THE DIMENSIONS

The dimension can be modified using the DIMEDIT
command (Figure 9-7). This command has four options:
New, Rotate, Home, and Oblique. The prompt sequence
that will follow when you choose this button is

Enter type of dimension editing
(Home/New/Rotate/Oblique) <Home>: Enter an option.

New
The New option is used to replace the existing dimension with a new text string. When you
invoke this option, the In-Place Text Editor will be displayed. By default 0.0000 will be displayed.
Write the dimension or text string  using this In-Place Text Editor, with which you want to
replace the existing dimension. Once you have  written a new dimension in the editor and
chosen OK, you will be prompted to select the dimension to be changed. Select the dimension;
it will be replaced with the new dimension.

Rotate
The Rotate option is used to position the
dimension text at a specified angle. With this
option, you can change the orientation (angle)
of the dimension text of any number of
associative dimensions. The angle can be
specified by entering its value at the Specify
angle for dimension text prompt or by
specifying two points at the required angle.
Once you have specified the angle, you will
be prompted to select the dimension text to
be rotated. You will notice that the text rotates
around its middle point, see Figure 9-8.

Home
The Home option restores the text of a dimension to its original (home/default) location if the
position of the text has been changed by stretching or editing, see Figure 9-8.

Toolbar: Dimension > Dimension Edit
Command: DIMEDIT

Figure 9-7  Invoking the DIMEDIT
command from the Dimension toolbar

Figure 9-8  Using the DIMEDIT command to edit
dimensions
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Figure 9-9  Using the Oblique option to edit dimensions

Toolbar: Dimension > Dimension Text Edit
Menu: Dimension > Align Text
Command: DIMTEDIT

Oblique
In linear dimensions, extension lines are drawn perpendicular to the dimension line. The
Oblique option bends the linear dimensions. It draws extension lines at an oblique angle
(Figure 9-9). This option is particularly important to create isometric dimensions and can be
used to resolve conflicting situations due to the overlapping of extension lines with other objects.
Making an existing dimension oblique by specifying an angle oblique to it does not affect the
generation of new linear dimensions. The oblique angle is maintained even after performing
most editing operations. (See Chapter 21 for details about how to use this option.) When you
invoke this option, you will be prompted to select the dimension to be edited. After selecting it
you will be prompted to specify the obliquing angle. The extensions lines will be bent at the
angle specified. You can also invoke this option by choosing Oblique from the Dimension
menu.

EDITING DIMENSION TEXT

The dimension text can be edited by using the DIMTEDIT command. This command
is used to edit the placement and orientation of a single existing dimension. You can
apply this command, for example, in cases where dimension texts of two or more

dimensions are too close together, creating confusion. In such cases, the DIMTEDIT command
is invoked to move the dimension text to some other location so that there is no confusion. The
prompt sequence that will follow when you choose this button is given next.

Select dimension: Select the dimension to modify.
Specify new location for dimension text or [Left/Right/Center/Home/Angle]:
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Left
With this option, you can left-justify the dimension text along the dimension line. The vertical
placement setting determines the position of the dimension text. The horizontally aligned text
is moved to the left and the vertically aligned text is moved down, see Figure 9-10. This option
can be used only with the linear, diameter, and radius dimensions.

Right
With this option, you can right-justify the dimension text along the dimension line. Similar to
the Left option, the vertical placement setting determines the position of the dimension text.
The horizontally aligned text is moved to the right, and the vertically aligned text is moved up,
see Figure 9-10. This option can be used only with linear, diameter, and radius dimensions.

Center
With this option, you can center-justify the dimension text for linear, and aligned dimensions,
see Figure 9-10. The vertical setting controls the vertical position of the dimension text.

Home
The Home option is used to restore (move) the dimension text of a dimension to its original
(home/default) location if the position of the text has been changed, see Figure 9-10.

Angle
With the Angle option, you can position the dimension text at the angle you specify, see Figure 9-10.
The angle can be specified by entering its value at the Specify angle for dimension text prompt
or by specifying two points at the required angle. You will notice that the text rotates around its
middle point. If the dimension text alignment is set to Orient Text Horizontally, the dimension
text is aligned with the dimension line. If information about the dimension style is available on

Figure 9-10  Using the DIMTEDIT command to edit dimensions
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Toolbar: Standard > Properties
Menu: Modify > Properties
Command: PROPERTIES

the selected dimension, AutoCAD LT uses it to redraw the dimension, or the prevailing dimension
variable settings are used for the redrawing process. Entering 0-degree angle changes the text to
its default orientation.

UPDATING DIMENSIONS

The Update option regenerates and updates the prevailing dimension entities (such
as arrows heads and text height) using the current settings for the dimension variables,
dimension style, text style, and units. On choosing this button, you will be prompted to

select the dimensions to be updated. You can select all the dimensions or specify those that
should be updated.

EDITING DIMENSIONS WITH GRIPS
You can also edit dimensions by using the GRIP editing modes. GRIP editing is the easiest and
quickest way to edit dimensions. You can perform the following operations with GRIPS.

1. Position the text anywhere along the dimension line. Note that you cannot move the text
and position it above or below the dimension line.

2. Stretch a dimension to change the spacing between the dimension line and the object line.
3. Stretch the dimension along the length. When you stretch a dimension, the dimension text

automatically changes.
4. Move, rotate, copy, or mirror the dimensions.
5. Relocate a dimension origin.
6. Change properties such as color, layer, linetype, and linetype scale.
7. Load Web browser (if any Universal Resource Locator is associated with the object).

EDITING DIMENSIONS USING THE PROPERTIES
PALETTE

You can also modify a dimension or leader by using the PROPERTIES palette. The
PROPERTIES palette is displayed when you choose the Properties button from the
Standard toolbar. It can also be invoked by double-clicking on the dimension to be

edited. All the properties of the selected object are displayed in the PROPERTIES palette (see
Figure 9-11).

PROPERTIES Palette (Dimension)
You can use the PROPERTIES palette (Figure 9-11) to change the properties of a dimension,
the dimension text style, or geometry, format, and annotation-related features of the selected

Toolbar: Dimension > Dimension Update
Menu: Dimension > Update
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dimension. The changes takes place dynamically in the drawing.
The PROPERTIES palette provides the following categories
for the modification of dimensions are as follows.

General
In the general category, the various parameters displayed are
Color, Layer, Linetype, Linetype scale, Plot style, Lineweight,
Hyperlink, and Associative  with their current values. To change
the color of the selected object, select Color property and then
select the required color from the drop-down list. Similarly,
layer, plot style, linetype, and lineweight can be changed from
the respective drop-down lists. The linetype scale can be
changed manually at the corresponding cell.

Misc
This category displays the dimension style by name (for the
DIMSTYLE system variable, use SETVAR). You can change the
dimension style from the drop-down list for the selected
dimension.

Lines & Arrows
The various parameters of the lines and arrows in the
dimension such as arrowhead size, type, arrow lineweight,
and so on can be changed in this category.

Text
The various parameters that control the text in the dimension object such as text color, text
height, vertical position text offset, and so on can be changed in this category.

Fit
In the fit category, the various parameters are Dim line forced, Dim line inside, Dim scale
overall, Fit, Text inside, and Text movement. All the parameters can be changed by the
drop-down list except Dim scale overall (which can be changed manually).

Primary Units
In the primary units category, the parameters displayed are Decimal separator, Dim prefix,
Dim suffix, Dim roundoff, Dim scale linear, Dim units, Suppress leading zeroes, Suppress
trailing zeroes, Suppress zero feet, Suppress zero inches, and Precision. Among these
properties, Dim units, Suppress leading zeroes, Suppress trailing zeroes, Suppress zero feet,
Suppress zero inches, and Precision properties can be changed with the corresponding drop-down
lists. The other parameters can be changed manually.

Alternate Units
Alternate units are required when a drawing is to be read in two different units. For example, if
an architectural drawing is to be read in both metric and feet-inches, you can turn the alternate

Figure 9-11  The PROPERTIES
palette for dimensions
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units on. The primary units can be set to metric and the alternate units to architectural. As a
result, the dimensions of the drawing will be displayed in metric units as well as in engineering.
In the alternate unit category, there are various parameters for the alternate units. They can be
changed only if the Alt enabled parameter is on. The parameters such as Alt format, Alt precision,
Alt  suppress leading zeroes, Alt suppress trailing zeroes, Alt suppress zero feet, and Alt
suppress zero inches can be changed from the respective drop-down lists and others can be
changed manually.

Tolerances
The parameters of this category can be changed only if the Tolerances display parameter has
some mode of the tolerance selected. The various parameters are available and correspond to the
mode of tolerance selected.

PROPERTIES Palette (Leader)
The PROPERTIES palette for Leader can be invoked by
selecting a Leader and then choosing the Properties button from
the Standard toolbar. You can also invoke the PROPERTIES
palette (Figure 9-12) from the shortcut menu by right-clicking in
the drawing area and choosing Properties. This palette can also
be invoked by double-clicking in the leader to be edited. The
various properties under the PROPERTIES palette (Leader) are
described next.

General
The parameters in the general category are the same as those
discussed in the previous section (PROPERTIES palette for
dimensions).

Geometry
This category displays the coordinates of the Leader. The
parameters under this category are Vertex, Vertex X, Vertex Y,
and Vertex Z. You can choose any vertex of the leader and change
its coordinates.

Misc
This category displays the Dim Style and Type of the Leader. You can change the style name
and the type of the Leader by using these properties.

Lines & Arrows
Lines and Arrows displays the various specifications of the arrowheads and linetypes for the
Leader.

Fit
This category displays the Dim scale overall property that specifies the overall scale factor
applied to size, distances, or the offsets of the Leader.

Figure9-12  The PROPERTIES
palette for leaders
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Text
Text category displays the Text offset to the dimension line and the vertical position (Text pos vert)
of the dimension text and can be changed accordingly.

In this example, you will modify the dimensions in Figure 9-13 so that they match
the dimensions given Figure 9-14.

1. Choose Text Style from the Format menu and create a style with the name ROMANC.
Select romanc.shx as the font for the style.

2. Double-click on the dimension 2.25 to display the PROPERTIES palette.

3. In the Text category, select the Text style drop-down list and then select ROMANC style
from this drop-down list. The changes will take place dynamically.

4. Select 0.0000 from the Precision drop-down list in the Primary Units area.

5. Once all the required changes are made in the linear dimension, choose the Select Object
button in the PROPERTIES palette. You will be prompted to select the object. Select the
leader line and then press ENTER.

6. The PROPERTIES palette will not display the leader options. Select Spline with arrow
from the Type drop-down list in the Misc category. The straight line will be converted into
a spline with an arrow dynamically.

7. Close the PROPERTIES palette.

8. Choose the Dimension Edit button from the Dimension toolbar. Enter N in the prompt
sequence to display the In-Place Text Editor.

Example 2 Mechanical

    Figure 9-13  Drawing for Example 2 Figure 9-14  Drawing after editing the dimensions
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9. Enter DRILL AND REAM %%C0.25 HOLE (THROUGH) in the text editor and then
choose OK.

10. You will be prompted to select the object to be changed. Select the diameter dimension and
then press ENTER. The diameter dimension will be modified to the new value.

MODEL SPACE AND PAPER SPACE DIMENSIONING
Dimensioning objects can be drawn in the model space or paper space. If the drawings are in
model space, associative dimensions should also be created in it. If the drawings are in the
model space and the associative dimensions are in the paper space, the dimensions will not
change when you perform such editing operations as stretching, trimming, and extending, or
such display operations as zoom and pan in the model space viewport. The definition points of
a dimension are located in the space where the drawing is drawn. You can select the Scale
dimensions to layout (paperspace) radio button under the Scale for Dimension Features area
in the Fit tab of the Modify, New, or Override dialog boxes in the Dimension Style Manager
dialog box, depending on whether you want to modify the present style or you want to create a
new style (see Figure 9-15). Choose OK/OK to exit from both the dialog boxes. AutoCAD LT
calculates a scale factor that is compatible with the model space and the paper space viewports.
Choose Update from the Dimension menu and select the dimension objects for updating.

Figure 9-15  Selecting paper space scaling in the Modify Dimension Style dialog box
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The drawing shown (Figure 9-16) uses paper space scaling. The main drawing and detail drawings
are located in different floating viewports (paper space). The zoom scale factors for these viewports
are different: 0.3XP, 1.0XP, and 0.5XP, respectively. When you use paper scaling, AutoCAD LT
automatically calculates the scale factor for dimensioning so that the dimensions are uniform in
all the floating viewports (model space viewports).

Answer the following questions and then compare your answers to those given at the end of
this chapter.

1. In associative dimensioning, the items constituting a dimension (such as dimension lines,
arrows, leaders, extension lines, and dimension text) are drawn as a single object. (T/F)

2. If the value of the variable DIMDASSOC is set to zero, the dimension lines, arrows, leaders,
extension lines, and dimension text are drawn as independent objects. (T/F)

3. You cannot edit dimensions using grips. (T/F)

4. The true associative dimensions cannot be trimmed or extended. (T/F)

5. You can use the __________ command to break the dimensions into individual entities.

6. The __________ option of the DIMTEDIT command is used to justify the dimension text
toward the left side.

Figure 9-16  Dimensioning in paper model space viewports using
paper space scaling or setting DIMSCALE to 0

Self-Evaluation Test
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7. The __________ option of the DIMTEDIT command is used to justify the dimension text
to the center of the dimension.

8. The __________ option of the DIMEDIT command is used to create a new text string.

9. The __________ option of the DIMEDIT command is used to bend the extension lines
through the specified angle.

10. The __________ button from the Dimension toolbar is used to update the dimensions.

Answer the following questions.

1. The horizontal, vertical, aligned, and rotated dimensions cannot be edited using the grips.
(T/F)

2. Trimming and extending operations can be carried out with all types of linear (horizontal,
vertical, aligned, and rotated) dimensions and with the ordinate dimension. (T/F)

3. To extend or trim an ordinate dimension, AutoCAD LT moves the feature location (location
of the dimensioned coordinate) to the boundary edge. (T/F)

4. Once moved from the original location, the dimension text cannot be restored to its original
position. (T/F)

5. With the __________ or __________ commands, you can edit the dimension text.

6. The __________ command is particularly important for creating isometric dimensions and
is applicable in resolving conflicting situations due to overlapping of extension lines with
other objects.

7. The __________ command is used to edit the placement and orientation of a single existing
dimension.

8. The __________ command regenerates (updates) prevailing associative dimension objects
(like arrows and text height) using the current settings for the dimension variables, dimension
style, text style, and units.

9. Explain when to use the EXTEND command and how it works with dimensions.
______________________________________________________________________________.

10. Explain the use and working of the PROPERTIES command for editing dimensions.
________________________________________________________________________________.

Review Questions
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1.   Create the drawing shown in Figure 9-17. Assume the dimensions where necessary.
2. Dimension the drawing, shown in Figure 9-17.
3. Edit the dimensions so that they match the dimensions shown in Figure 9-18.

1. Draw the object shown in Figure 9-19(a). Assume the dimensions where necessary.
2. Dimension the drawing, as shown in Figure 9-19(a).
3. Edit the dimensions so that they match the dimensions shown in Figure 9-19(b).

Exercises

Figure 9-17  Drawing for Exercise 3, before editing
dimensions

Figure 9-18  Drawing for Exercise 3, after editing
dimensions

Exercise 3 General

Exercise 4 Mechanical

Figure 9-19  Drawings for Exercise 4
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Figure 9-20  Drawing for Exercise 5

Problem Solving Exercise 1 Mechanical

Figure 9-21  Drawing for Problem Solving Exercise 1

Exercise 5 Architectural

Create the drawing shown in Figure 9-20 and then dimension it. Assume the dimensions wherever
necessary. After dimensioning the drawing, edit them so that they match the dimensions shown
in Figure 9-20

Create the drawing in Figure 9-21 and then dimension it as shown. Edit the dimensions so that
they are positioned as shown in the drawing. You may change the dimension text height and
arrow size to 0.08 units.
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Draw the front and side view of an object shown in Figure 9-22 and then dimension the two
views. Edit the dimensions so that they are positioned as shown in the drawing. You may change
the dimension text height and arrow size to 0.08 units.

Figure 9-22  Drawing for Problem Solving Exercise 2

Problem Solving Exercise 2 Mechanical
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Figure 9-23  Drawing for Problem Solving Exercise 3

Problem Solving Exercise 3 Architectural

Create the drawing of the floor plan shown in Figure 9-23 and then give the dimensions as
shown. Edit the dimensions, if needed, so that they are positioned as shown in the drawing.

Answers to Self-Evaluation Test
1 - T, 2 - T, 3 - F, 4 - F, 5 - EXPLODE, 6 - Left, 7 - Center, 8 - New, 9 - Oblique,
10 - Dimension Update


